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Editorial policy

The South African Society for Animal Science (SASA&Icomes the submission of manuscripts
from members of the South African Society for AniiBaience and from scientists in Africa and abroad
on all matters germane to teeience of animal productiorfor publication in the South African Journal
of Animal Science (SAJAS). The scope of the journaludes reports of research dealing with farm
livestock species (cattle, sheep, goats, pigs andtrg), as well as pertinent aspects of reseamh o
aquatic and wildlife species. The main disciplires/ered are nutrition, genetics, physiology and
production aspects of animal products. Papersrdgalith sociological aspects of well-defined livaskt
production systems are invited, providing they seientific by nature and have been carried out in a
systematic way. Papers dealing with routine, régetitesting or economic evaluation of specific
products, feeds or cultivars, case studies or msatlealing with agricultural extension or consumer
issues are discouraged unless the results so dexieaused to develop or elaborate scientific qotsde
the field of animal science. Papers that form péra series are discouraged: this includes difteren
aspects of data derived from one particular expgamimor cases in which the analytical techniques,
animals or experimental procedures are common ltpagders. Where authors have valid reasons for
separation of reports into two manuscripts, thegstine submitted simultaneously; delayed or stagher
submissions will automatically be rejected. Incates, reports should represamginal contributions to
current scientific knowledgef theprinciples or theapplication of principles governing the functioning
of animals, production aspects of their productsl dneir relationship to the social or physical
environment.

Publication fee per article published (2011)

SASAS member is one of the authors: R 500.00 (etfEfvalent(SASAS members may apply for
exemption of the publication fee)

Non-members in RSA and SADC: R 1000.00

Non-members, rest of Africa and overseas: US$ 200.0

This will be levied upon acceptance of manuscript.
No reprints are supplied.

Revising / editing language of manuscript
Can be arranged at a fee of US$ 100.00.

Types of articles
All submissions will be subjected to the peer-revgrocess.

Research articles

Contributions should be based on original unpublisbxperimental data that have been analysed
using statistical methods. Multi-part manuscripgsived from a common experiment will not be
considered unless submitted simultaneously.



Short communications
Results from a limited investigation, work still pmogress and new techniques can be submitted as
a short communication. It should not exceed fivatpd pages. (See Instructions below).

Proceedings of Congresses, Conferences or Symposia

Proceedings of presentations delivered at congsesSéhe South African Society for Animal
Science, international conferences held under tspiees of SASAS or other symposia of
regional branches or interest groups of the Sodtaty be published as separate “Conference
proceedings” issues of the journal. Contributionls be subjected to the same peer reviewing as
required for SAJAS, and a publication fee will beaged (to be negotiated). Organisers of such
events should contact the editor-in-chief to enshat peer-review procedures and formatting of
abstracts are compliant with those of the journal.

Reviews

Reviews should have as their main aim the synttasigplication of new principles, hypotheses
or future research directions from re-interpretatand scrutiny of existing published scientific
data. It is normal practice for authors to inclsdene of their own new but previously unpublished
data in support of the concept that is synthesi§ymtheses and applications from technical
reports, surveys and other unpublished but sciealij justifiable sources of information can also
be used in support. Reviews aimed at distilling#xg published information into a form that will
contribute to a clearer understanding of, or moigespread application of research findings by
generalist extension officers and non-scientistsadso welcomed. Reviews are normally solicited
by the editor-in-chief, but suggestions for topicsauthors are welcomed. Reviews are subjected
to the same peer-review process as is applied tbhalr submissions.

Electronic publication

The South African Journal of Animal Science is jml#d electronically via the Internet, and can
be accessed from the following address: http://vaasas.co.za/publications or through
http://www.sasas.co.za

One volume will be published per year, consistifgab least three issues, published at
approximately 3- to 4-month intervals. Articles iwilowever, be placed on the Internet as soon as
the copy-ready version has been approved by thaitiuiy author.

Copyright

Copyright resides with the authors in terms of@neative Commons Attribution 2.5 South African
Licence. See: http://creativecommons.org/licens#3/6/za/

Condition of use: The user may copy, distributensmit and adapt the work, but must recognise the
authors and the South African Journal of Animak8ce

Once an article has been accepted for publicati@ncorresponding author will receive an Agreement
document between SASAS and the authors, which babet signed by all authors and returned
(electronically) to the editor-in-chief. The cap®nding authors will also receive the final probthe
article.

Submission and the review process

The data upon which all types of manuscripts arsetbashould be original (except review articles),
should not have been published previously in a-ppgewed scientific journal, and should not be emd
consideration for publication elsewhere. Submis®b@a manuscript is understood to imply that these
conditions have been met. The context and/orIdgft#he new findings must be sufficiently diffeten
merit addition to the matrix of knowledge througlbpcation.



Submission also implies that all authors have ammtdhe submission and are in agreement with its
content.

If figures, tables or parts of other copyright metlenot owned by the authors are included in batic
submitted for publication in the journal, it is thele responsibility of the authors to obtain pesiun to
republish such items.

A sub-editor with the assistance of reviewers Ww#él requested to review the manuscript and make a
recommendation to the editor-in-chief.

Authors may suggest a list of experts whom theysmwar especially suitable to referee their paper,
especially if the subject is highly specialized.

The editor-in-chief will advise the correspondingtteor on the outcome of the review based on the
recommendation of the sub-editor.

Resubmitted manuscripts will follow the same prece$ evaluation as the first submission. Any
resubmittal should be accompanied by a summarjhefchanges made and a brief response to all
recommendations and criticisms.

NB: Initially a paper is accepted provisionally. Thadl decision to accept or reject manuscripts for
publication resides with the editor-in-chief. Ietleditor-in-chief considers it necessary, the papay be
referred to the journal's editorial sub-committee & final decision regarding acceptance.

Style and Form

Manuscripts will not be admitted to the peer-revigrocess until they are fully compliant with thglet
and format detailed in the instructions to authors.

Authors are requested to adhere strictly to thieviehg directives and consult the most recent edgiof
the journal for issues not specifically mentionedeh The manuscript must be written in Englishngisi
the UK English spell check. (i.e. do not expresisuim calories, pounds, miles, etc.). It is upthe
authors to make sure there are no typographioaiseim the manuscript.

Submissions should be typed in MS WORD (or savedoasfiles) and submitted as e-mail attachments
to the editor-in-chief, preferably at jvryssen@ujxza, but also at editor@sasas.co.za

» Thetitle must be informative and brief (if possible in pudicte form to draw attention). The
initials and name of the author(s), the addreshefinstitution where the work was done must
follow the title. Superscripts (1,2,3) should bedisn cases where authors are from different
institutions. The superscriptshould be appended to the author to whom correspme should
be addressed, and indicated as such together witk-raail address in the line immediately
following thekeywords. The present postal address of authors, if cuyréiferent from that of
the institution, should also be superscripted gmpaitely and inserted in the lines following that
of the corresponding author’s details.

* An abstract should be included next. It should contain theofeing: purpose of study,
experimental treatments, results, preferably imgtative data, significance of findings and the
conclusions. This should not exceed 250 words.ifttggnce levels (e.gP? <0.05) should not be
included in the abstract.

The abstract is followed by a list Keywords: - Keywords preferably ones not used in the title.



* Thecontentsmust be arranged in an orderly way with suitablediregs for each subsection. The
recommended subdivision of contents is as follows:

* Introduction : This should include (a) a statement of why thigjestt under investigation is
considered to be of importance, (b) a concise aidin of the status quo of published
research in this field and (c) why this articlecnsidered to be amriginal contribution to
current scientific knowledgef theprinciples or theapplication of principles governing the
functioning of animals, production aspects of th@ioducts and their relationship to the
social or physical environment. The last sententéhe introduction should contain a
declaration of the aims of the experiment, i.e. higpothesis. The introduction should not
exceed one page in length.

* Materials and Methods: These should be concise but of sufficient detaietable the
experiment to be replicated by an outside partgtiSical methods used must be clearly
stated. (See instructions below on “Statisticappration of response trials).

* Results and Discussiommay be treated separately or under one headingptmsert sub-
headings. Integrity in reporting requires that noonsistent data are omitted or fabricated
data presented.

» Conclusions:This should consist of (a) a short integratiomesults that refer directly to the
stated aims of the experiment and (b) a statemethepractical implications of the results.
This section should not exceed one short parag2pimot summarise the discussion here.

* Acknowledgements: Do not include titles of persons; use only ingisdnd surnames.
Acknowledge financial support from the NRF, andlude their project GUN number, as
required by the NRF. State and acknowledge spenspecifically if private companies
funded the research.

* Footnotesare not acceptable.

Main text: Font size 11 pt. The settings for the paragraphshould be as follows: format > paragraph
> indentation: special; first line, and the aligmmef all paragraphs is set as ‘justified’ so ttiare are
no ragged edges on the right-hand side of the page.

Do not introduce sub-headings into the main heading @est separate different sections using
paragraphs. Do not leave open lines between panfagjra

Tablesare numbered consecutively in bold Arabic numei@lg.Table 1 note that there is no following
colon or full stop and should bear a short, yet adequate descriptipgion (i.e. the caption should
enable interpretation of the data presented iftéitsee and caption were to be separated from thig. tex
Example: inadequateTable 1 Feed intake effects”; correctTable 1 Mean (x SE)voluntary intake
(g/d) of two diets differing in crude protein contéy early-weaned (21 d) piglets”. (Font size:[tL
Measures of variance (e.g. SE or SD) includedhbietashould be clearly defined in the caption afén
preceding example. Metric units are to be cledntywa, symbols and abbreviated must be in accordance
with international procedure. Explanatory notesatile elements are designated by superscriptsthend
explanation should appear on the lines directlpwehe table. Differences between table means dhoul
be designated using superscripts (superscript gHollbw the mean in the table and not the SE) thied
following conventional explanatory note which stibappear on the line directly below the taj{&*
Row means with different superscripts differ sigraihtly atP <0.05". Tables should be centred on the
page. Authors should pay special attention to thméat for tables regarding lines, i.e. no vertioas
and horizontal lines before and after the headimjthe last row of data only (see recent journtitlas

for examples). Each entry in a separate cell ifetakables should be inserted at the appropriateepin
the text (do not append tables at the end of thieer Table contents (including table footnotskpuld

be typed using Times New Roman 10 point font.

Do not import tables from other packages. Writarthe MS WORD! Tables must fit on a single page,
according to the Page set-up instructions. Largkesawill not be accepted.



lllustrations anddiagrams. These should be inserted into the text at thpeagypiate position. Graphs*
that have been scannedare not acceptable Graphs could be constructed using MS Excel aseriad
into the text. All lettering and numerals that agpen figures should be set Tmmes New Roman 10
point font in “regular” not “bold”. Coloured lines should nbe usedsequence differences should be
indicated by symbols. Point means should, whersiples be accompanied by standard error bars. Tic
marks on axes should face towards the inside ofthgh. Figures should be numbered consecutively in
bold Arabic numeralsHigure 1). Avoid the use of “shading” in illustrations.

Place its title underneath the Figure, but notaat @f the inserted section.

Do not “block” the figure with lines surrounding it
*If graphs, diagrams, etc. are imported from e.dg HExcel, copy it and then under "Edit", use "Paste
Special" and "Picture" to insert in document.
Ensure that lines, including axes and graphs, agéth Faint/thin lines tend to fade when hard espare
printed.

Terminology, abbreviations and formulae: Use the SI metric system (US Metric Association)
(http://lamar.colostate.edu/~hillger/correct.htrj @inits of measurement and use a decimal poipell S
out numbers from one to nine; use numerals forelargmbers, groups of numbers, fractions or units,
e.g. four; 8 - 16; 4 kg/ha; 42 ewes, 67%. Note gpacing in the following text? <0.05 (noteP in
italics); 5 min. For litres, use the abbreviatiomtmL. When reporting concentrations of, for imsta,

the chemical composition of diets, use g/kg and¥aping/kg and not ppm; mg Cu/kg and not mg/kg Cu;
do not use the word “content” when specifying aasariration in terms of, for instance, g/kg or %seU
percent mainly to indicate relative changes.

When abbreviations are used, they must be explamédl the first time the concept is used, also i
tables and figures. Do not start a sentence withbdomeviation.

Express nutrient concentrations of feeds preferainlya dry matter (DM) basis and indicate the basis
clearly in the table.

Do not use the word ‘significantly’ where the lexd#l significance is declared: e.g. use ‘Treatment A
differed P <0.01) from treatment B’ andot ‘Treatment A differed highly significantly®(<0.01) from
treatment B'. Where means do not differ signifitgrthe appropriate level of probability could lated
e.g. “---did not differ P >0.05)". Note the following syntax “variables diff between treatmentsiot
“variables differ among treatments”. For standamdreuse the abbreviation SE, for standard dewatio
use SD and for standard error of the mean, use SEM.

Statistical preparation of Response trials

The objective when conducting a response triabista prove that one treatment is significantly
better than another but to describe the responskeinamost cases, to find the optimum dose (whiely m
be that which produces the maximum response, thenmam response or the optimum economic
response), so the number of doses (treatmentsiriescmore important than the number of replications.

The most common method of analysing data from a/desponse experiment is Duncan’s
multiple range test (Duncan, 1955), but in all sadgs is the incorrect procedure, as the compariso
between treatments (doses) by means of a multgpiger test is inappropriate when there is a logical
structure to the set of treatments, and the useaonventional 5% level of significance is inappraig
when trying to obtain the best estimate of somepaiat (Chew, 1976; Morris, 1983; 1999). A respons
surface must be fitted to the data and used tgpreethe results.

The means of all variables measured should be mextén a table, together with the standard
error (SE) of the mean or residual mean squarewitht no super- or subscripts indicating statidtica
differences between means. The coefficients otthee fitted to the data need to be displayedttaye
with their SE’s. When graphing the results, theuaktimeans for each level of the factor should be
displayed and not the fitted means, and the coaotisufunction fitted to the data should be drawn
through these means. It is incorrect to use achart when illustrating a response experimenthiss t
implies that the factor levels were independerstinents, which they are not.



Ethical

Where

References

Chew, V., 1976. Uses and abuses of Duncan's naltgsige test. Proc. Fla. State Hort.
Soc. 89, 251-253.

Duncan, D.B., 1955. Multiple-range and multipleeBts. Biom. 11, 1-42.

Morris, T.R., 1983. The interpretation of respowks¢a from animal feeding trials. In:
Recent Advances in Animal Nutrition. Ed. Haresiyv, Butterworths, London.
pp. 12-23.

Morris, T.R., 1999. Experimental Design and Anayén Animal Sciences. CABI
Publishing, Wallingford, U.K.

applicable animal experimentation must belgoted within standard ethical norms. A statement

indicating compliance to that must be includedhi@ Materials and Methods section.

References

The existing relevant literature must be approplyatind fairly cited; in this respect reference
efforts are always made to ensure that refereneceage to theoriginal report of a finding
rather than to a later elaboration.

References appearing in the text

Cite references by name and date in parentheséise loase of two authors, use an ampersand
(&) and not “and”. The abbreviatioret al.” must be used in all cases where more than two
authors are quoted. Personal communications andblisped work should be cited in the text,
giving the initials, name and date; they should aypear in the list of references. All other
references in the text should be listed alphaldgtibg first authors’ surnames at the end of the
paper under the heading, “References”. Multiplenefices within parentheses in the text should
be cited in chronological order. Examples:

» Apart from the work of Chevallerie & Smith (197Neary (1991) and Lewigt al
(1997), little data........

* and has been shown to increase the pH (Chevadle@mith, 1971; Veary, 1991, Lewis
et al, 1997). (note: comma aftet al, not in italics).

* Do not put “Reference (1991, cited by Lewet al, 1997)” in text, but in list of
references, viz. Reference, A.B., 1991. Full orilate title. Journal name volume and
pages (Cited by Lewist al, 1997). (See references of Scott and Taintdistifvelow).

» Personal communications: According to Brightguyo02, A.B. Brightguy, Pers.
Comm., Centre of Wisdom, P.O. Box 100, Pretoria)1Q0- Enough details so that
person could be contacted.

References appearing in the list, “References”, dhe end of the article:

Journal names must be abbreviated according té/tivéd List of Scientific Periodicals. Authors
should pay special attention to the syntax usatiernreference list and check that references in
the text correspond completely and exactly witlséhgiven in the reference list.

In all cases, a reference must provide sufficiefdrimation to enable the reader to obtain a copy
of it; references to unpublished congress predentaire NOT acceptable.

Reference to internet articles is permissible. ufydl traceable reference in list.

NB: It isthe FULL responsibility of the authors to cross-check references in the text of the
articlewith thosein thelist of references.



» Examples of references(Hanging indent 1 cm)

AOAC, 1984. Official methods of analysis (14th ed3sociation of Official Analytical Chemists,
Inc., Arlington, Virginia, USA.

Hoffman, L.C. & Ferreira, A.V., 2000. pH decline thie M. longissimus thoracisf night-cropped
grey duiker Sylvicapra grimmia S. Afr. J. Anim. Sci. 30, 16-17.

Lawrie, R.A., 1998. Lawrie’s Meat Sciencd' &d. Woodhead Publ. Ltd. Cambridge, England. 336

pp.
NRC, 1984. Nutrient Requirements of Beef Cattld @d.). National Academy Press, Washington
D.C., USA.

Read, M.V.P., 1984. Animal performance from natypastures and the effects of phosphorus
supplementation. MSc (Agric) thesis, UniversityStéllenbosch, South Africa.

SAS, 1985. Statistical Analysis Systems user'sg(bth ed.). SAS Institute Inc., Raleigh, North
Carolina, USA.

Scott, J.D., 1947. Veld management in South Afridall. Dept. Agric. S. Afr. No. 28. (cited by
Tainton, 1999).

Sutton, J.D., 1976. Energy supply from the digestiract of cattle. In: Principles of Cattle
Production. Eds Swan, H. & Broster, W.H., Butterther London. pp. 12-22.

Tainton, N.M., 1999. The ecology of the main grazitands of South Africa. In: Veld
Management in South Africa. Ed. Tainton, N.M., Uity of Natal Press,
Pietermaritzburg, South Africa. pp. 48.

» Atrticles in foreign languages:

Yalgin, H., 1997. Central North Anatolian zeolitecarrences related to Eocene submarine
volcanism in Turkey. Bull. Eng. Fac. Cumhuriyet WUnBerie A-EarthSci. 14, 43-56 (in
Turkish, English abstract).

Tarkoglu, M., Arda, M., Yetsir, R., Sarica, M. & Erensayin, C., 1997. Broilegoguction. In:
Poultry Science, Otak Form-Ofset, Samsun. pp.1&/ (8T urkish).

» Sequence of references with the same first authond more than one co-author(i.e. where
reference in text is given @t al) Sequence, chronological!

Cloete, S.W.P., Van Schalkwyk, S.J. & Brand, Z.98.90strich breeding — progress towards a
scientifically based strategy. Pro&? mt. Ratite Cong, Oudtshoorn, South Africa. pp-6&5

Cloete, S.W.P., Lambrecht, H., Punt, K. & Brand,Z001. Factors related to high levels of ostrich
chick mortality from hatching to 90 days of ageaimintensive rearing system. J. S. Afr. Vet.
Assoc.72, 197-202.

Cloete, S.W.P., Bunter, K.L., Brand, Z. & Lambrex;htl., 2004. Co-variances for reproduction,
egg weight and chick weight in ostriches. S. AfrAdim. Sci. 34, 17-19.

Cloete, S.W.P., Engelbrecht, A., Olivier, J.J. &nBar, K.L., 2008. Deriving a preliminary
breeding objective for commercial ostriches. AUsExp. Agric. 48, 1247-1256.

Style and format of Short Communications

A short communication should be a maximum of fiegs. It contains a very brief abstract followed by
a brief introduction, text including tables andufigs and a brief conclusion followed by referents.
subheadingsare to be included except for the Abstract. Forrtadtles and figures must conform to the
conventions of the Journal.



SUMMARY OF FORMAT
Submissions wilhot be accepted unless formatted as follows:

Page size: A4

Line numbering OFF

Page numbering ON - position: top right, font: Teidew Roman 10 point
Line spacing: single

File > Page Setup> Margins
Top: 3cm

Bottom: 2.5 cm

Left: 2 cm

Right: 2 cm

Gutter: 0 cm

Header: 1 cm

Footer: 1.4 cm

File > Page Setup>Paper size
210 X 297 mm (A4)

Insert > Page numbers
Position: Top of page (header)
Alignment: outside

For main text (excluding headings) use the follagyvin
Format > Font >

Font: Times New Roman

Style: Regular

Size: 11 pt

Format > Paragraph

First line of paragraph: first line indent: 1 cm
Line Spacing: Single

References: hanging indent: 1 cm

Symbols: Whenever possible, use “normal text”.

Title: Maximum 110 characters, Font size: 14 pt, bold, centred (no period)
14 pt
S.S. Authorg, T.T. Co-author: Font size: 12 ptbold, centred(no period)

Affiliations, including countryfont size: 10 ptcentred
10 pt
12 pt

Headings (e.g. Abstract, Material§pnt size: 12 ptbold

Keywords: Words not in title Font size: 11 pt
#Corresponding author: editor@sasas.cofant size: 10 pt



